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Installation

Install Battery, Software & Driver according to User Manual. To use the data logger, take the following steps:

1. Make sure the battery is correctly installed, or if you use USB port to power the data logger directly, you must
not remove data logger from USB port when the data logger is logging.

2. Insert the data logger into an available USB port of a PC which has installed the Data Logger Graph software
and driver.

3. Double click on the Data Logger Graph icon on your Windows desktop. This will load the Data Logger Graph
software. On the left top of the software main screen, you can see Start button and click on it. This will open
Data Logger Device dialog.

4. Select data logger device that will be set (or default). Here you can check the firmware version, status, etc. of
the selected data logger device.

5. Click on the Setup button to load Data Logger Setup dialog. Here you can follow the screen instructions and

setup the data logger (or default if first attempts).

Click on the Finished button. The data logger will start according to your settings.

7. Remove the data logger from PC USB port except USB port will be used as power supply as your required.
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8. When a task is finished, you can download data to PC. Do according to step 2 to 4 above firstly, and then click
on the Download button on the Data Logger Device dialog. Here you can follow the screen
instructions to download and save the data to PC. Please note that you need to input correct password to
operate this step if the data logger has been set a password before (No for factory default).

9. You can use the Data Logger Graph software to graph, analyze and print the data, and export the data to other
file formats (xls, txt, jpg, etc.).

Data Logger Setup

Double click on the Data Logger Graph icon on your Windows desktop. This will load the Data Logger Graph

software. On the left top of the software main screen, you can see Start > button and click on it. This will open
Data Logger Device dialog.




B8 Data Logger Device (e S

Data Logger Device Information and Status

Setup Setup and start the

Select Device(S/N) [141112RHT0010339 v data logger.

LED

Device Description  Temperature, Relative Humidity and De

Stop the data logger

Fimware Version 1.2 Download | and download data to
your PC

Password Bxist No password

Logger Status Finished

Battery Status oK Insert the data logger
) into USB port.and view
[ Start Logging ] | Stop Logging ] [ Refresh ] [ Details... ] Realtime real time measuring

data.

« Select Device: All connected data logger devices will be listed, and you can select a data logger device that will
be set. Each data logger device has a serial number arranged by factory. Move and put the mouse on the LED
button. You can see the yellow LED flash on the case of the selected data logger. The selected device
information and status will be shown, including device description, firmware version, password exist, logger
status and battery status. Click on the Refresh button, user can refresh the selected device information and
status manually.

Click “Details” button to see the details and status of the selected data logger. Click “Stop Logging” to stop
current logging.
Click “Start Logging” to start logging directly without re-setup.
« Setup: Click on the Setup button to open Data Logger Setup dialog.
Select the General tab.

' N
Data Logger Setup - 130821NTC0000020(Connected) e S

General | Channel Settings | Start and Stop Method | Advaced |
Logger Name

Name the data logger to give it a unique identity.
Logger Name NTC Data Logger (Max 30 char)

Sample Rate
Select time interval for a data logging.

Sample Rate | 10s v]

Password

Tick the "Password” and enter max. 6 digits(0™9), and it will need you to enter the same
password when download data next time. NOTE: if you forget it, you can't download data and
all data will be lost.But you can setup again to restart logging in any case.

[] Password

Again

| Finish | [ Cancel |

—_

Logger Name. Name the data logger to give it a unique identity.

2. Sample Rate. Select time interval to instruct the logger to log readings at a specific rate.

3. Password. If user set a password for the data logger, it will need user to enter the password when download
data.

Then, select the Channel Settings tab. Here it lists all channel related settings.



Data Logger Setup - 130819RHT0000006(Connected)

General | Channel Settings | Start and Stop Method | Advaced |

Description. Name the channel.
Status. Double-click to show a pop-up menu, and user can Enable or Disable the channel.

Unit. Double-click to show a pop-up menu, and user can select the unit for the channel.

Low Limit/ High Limit. Here allows user to set low/high alarm limit.

LED Alarm. User can select or unselect to enable or disable LED Alarm when Logged readings exceed the
low/high alarm limit.

Data Logger Setup - 130819RHTO000006(Connected)
General | Channel Settings | Start and Stop Method | Advaced |

Instant
[ amrm [ Hoe Instant

« Alarm Hold. Tick Hold to continue indicating an LED Alarm condition even when the logged readings have been
returned within the set alarm limit.
« Sample Mode. When the sample rate is more than internal basic sample rate, the readings between sample rate



interval will be processed as below
o Instant. Ignore the readings between sample rate intervals.
o Average. Get the average of all the readings between sample rate intervals.
o Maximum. Get the maximum of all the readings between sample rate intervals.
o Minimum. Get the minimum of all the readings between sample rate intervals.

Data Logger Setup - 130819RHT0000006(Connected)
General | Channel Settings | Start and Stop Method | Advanced |

« Calibration. It can support up to two point calibration. Target is the value that will be calibrated. Actual is the
actual value for target value.

Important Note: Measurement error will occur if user does any calibration incorrectly. User can clear wrong
calibration value. See the advanced tab for more details.
User must input 0 for all target and actual if user don’t want to change any calibration settings.

Then, Select the Start and Stop Method tab.

Data Logger Setup - 130821RHT0000025(Connected)

| General | Channe! Settings | Start and Stop Method | Advanced |
Start
Select how or when to start logging.

@ Start Immediately  Data logger wil start logging when setup is finished.
(©) Start by Buiton Press and hold the button until the green LED lights to start logging.
() Start at Data logger will delay to start urtil the DATE and TIME which are set

below. I

Date 2013/ 8/21 = Time 16:26:55
Stop
Select how to stop logging.
@ Stop When Full Data logger will stop when memory is full.
) Overwrite When Full Logger continues to log whan memory is full and the oldest data

will be overwritten

) Sample Points Data logger will log the specified sample points, and then stop.

| 16000 ]

Logging Duration 1 Days-20 Hours-26 Minutes-40 Seconds

1. Start Method. Select how or when to start logging.
2. Stop Method. Select how to stop logging. Note that if user selects “Overwrite When Full”, user can stop logging
via the button on the housing of data logger.



3.

Logging Duration. Indicate duration time under the settings.

Finally, select the Advanced tab.

Data Logger Setup - Demo |
| General | Channel Settings | Start and Stop Method | Advanced |
LED
/| Green LED Indication for Logger Status  Including LOGGING, DELAYED and FINISHED
status.
LCD
| The LCD Always On The LCD is always on, and & won save power
Clear Calibration Alarm Phone Number
| ClearCalbration | [ 5MS Alam Phone Number Setup |
Select Themmocouple Type
@ Type K 2 Type J O Type T () TypeR O Type S
Alam Delay
@ No Delay 10 min. 30 min, &0 mir.
Scale and Offset
Output Unit Point 1 Input 0 Display Output 0
e Pont2 Input 0 Display Output 0
[ Fnish | [ Cancel |

A WO =

. LED. User can enable or disable the green LED indication for logging status.

. LCD. If user ticks it, the LCD always on (Only for some specific product)

. Clear Calibration. User can reset and clear calibration that be set on data logger before.

. Select Thermocouple Type. Select thermocouple type for data logger (NOTE: Only for specific

model)

. Alarm Phone Number. Click “SMS Alarm Phone Number Setup” button. Enter the mobile phone number via

which you want to get the alarm message when SMS alarm appears. 5 mobile phone numbers available at
most and please make sure the integrality and the accuracy of the input numbers, otherwise users can not
receive the SMS normally. Meanwhile, users can query the Data Logger readings and battery status by dialing
the Data Logger and this number will be written into the alarm number list automatically. Notice: the top mobile
number in the 5 numbers list will be forced to delete if Data Logger being written more than 5 numbers. (NOTE:
Only for specific model)

SMS Alarm Phone Number Setup

Up to 5 Phone Number

Clear

: i

Clear

Clear

Clear

Clear

[ ok | [ Eat |




6. Alarm Delay. Users can select alarm delay. Data logger will start alarm after the selected delay time(NOTE:
Only for specific model)

Click on the Finish button to setup. Press the Cancel button to abort the setup.

Notes:

« Any stored data will be permanently erased when Setup is finished. To ensure you to save this data before it is
lost, click Cancel and then you need to download data.

o The battery will likelihood run out before logger will have finished specified sample points. Always ensure that
the remaining charge in the battery is sufficient to last the complete duration of your logging exercise. If in
doubt, we recommend that you always install a fresh battery before logging critical data.

« If user selects the “Start by Button”, please start logging manually.

Data Download

On the left top of the software main screen, you can see Start button and click on it. This will open Data Logger
Device dialog.

. Data Logger Device ]

Data Logger Devica Information and Status

. Sstup Setup and start the
Select Device(S/N) | 141112RHT0010935 A data lngger.

LED

Device Description  Temperature, Relative Humidty and De

Stop the data logger
Firmware Wersion 12 Download | and download data to
your PC

Password Exist No password

Logger Status Finished

Battery Status oK | inset the data logger

. - - into USB port,and view
Start Loggng | [Stop Logoing | | Refresh | [ Details... Realime |l time measuing

data.

(B ]

1. Select Device to download data.
2. Click on the Download button and input password if existed, and a Save dialog will be shown.

.
Access Password ﬁ

Please anter the access password:

OK _ Cancel |

|

3. Specify the saved path and name the saved file. Click on the Save button to save data.



'- Save “

O-(:;‘_l- Desktop » - |"? | | Search Desktop el
Organize * New folder e - (7]
W Favorites et Hr

Systern Folder =
- Libraries

admin
;J! Cnmpl.rler = System Folder
& Windows?_05 (C
) | Computer
= Local Disk (D) L

| Systemn Folder
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[=) Microsoft Office | Metwork
8 st | System Folder

File name: -

Save as type lLoggu Files (*.dig) vJ

~ Hide Folders Save [ Cancet |

4. When downloading finished, a dialog below will be shown, and user click “Open” to open the downloaded file
directly, or click “Add” to add the downloaded file to current graph, or click “Nothing” to exit.

| oo, | 25

Click "Open” to open this downloaded file, or Click “"Add" to open this
downloaded file in multi-graph mode.

Realtime Readings

When the data logger connected to PC, user can view the real-time readings.

-
8 Data Logger Device [t

Data Logger Device Information and Status —————
Setup and start the

Select Device(S/N) [ 130821NTC0000020 - | i looger:

Device Description  Temperature Data Logger Realtime Window
Stop the data logger

At Dowrload | and rc‘""'ﬂad datato LOGGER: 13082 1NTC0000020
your

Password Bt No password Channel 0

W= 31.0 °

Battery Status 0K ) Ug‘aedda :
. into port,and view
[Refresh] [ Stop | [Detais.. ] Reatime | o2l time measuring
data.

Stop Logging

User can click on the Stop button to stop logging if the data logger is logging.



(8 Oate logger Device ‘ | % 7] [ostatoggerGraph
Data Logger Device Information and Status S
Setup Setup and start the @ Are you sure to stop logging?
Select Device(S/N) | 130821NTCDD00020 - data logger.
Device Description  Temperature Data Logger
Stop the data logger
Frmware Version 1.0 Download | and download datato
your PC
Password Bxst No password
e e
into USB port.and view
(Refresh | ([ Stop | | Detais...] roo e momsing
jata.

Logger Details

Click on the Details button to view the information and status details for the data logger.

B8 Date Logger Device ‘ % Information and Status Details ‘
Data Logger Device Information and Status

Select Device(S/N) [ 130821NTC0000020 -

Device Description  Temperature Data Logger

Fimware Version 1.0

Password Bxist No password

Battery Status 0K

(i) l&n]

Software Interface

=¥, kkk.dig - 130812D000000024 - Temp. and Humi. Logger

The above picture show the following information:

1. Standard Toolbar



Zoom and Pan Toolbar
Graph Toolbar
Grid line
The left vertical axis
The right vertical axis
Graph line
Floating line
9. The horizontal axis
10. The readings for the current floating line
11. Legend
12. Graph background
13. Page background
14. Graph list window
15. Statistics window
16. Data table window
17. Main menu

© N O k~wDN

Open File

Click on the second icon on the standard toolbar or click on the Main Menu->File->Open to open the *.dIg or *.mdlg
file.

- o]
BB Dats Logger Graph =1 Bl
File Logger Help
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Add File and Multi-Graph Mode

The software can support several files are shown in a graph interface. User can click on the third icon or Main Menu-
>File->Add File to add files to current graph interface. User can compare and analyze the files using this function.



B8 Multi Graphlmdlg® - Data Logger Graph i)

Fie Edt Graph Llogger Tool Help
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The graph line with A letter is a file, and the graph line with B letter is another file. User can save it to a new *.mdlg
file. Note that the *.mdlg file need the original *.dlg file to graph correctly.

Zoom and Pan

File Edit Graph | Lopger Tool Help

» ‘: Graph Color Mode » |&|& |E
}: kkk.dlg Legend Location ]
— Grid Line Options k
[#: | Mark Data Paints Temp. and F
[ | Graph settngs... Ctl4G g Humi. Logger: Temp.{
Zoom and Pan Method b o Auto A
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@
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@ 1920
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Zoom and Pan Tool... *
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Zoom and Pan Method

« Auto Zoom and pan in any direction

« Horizontal Zoom and pan only in horizontal direction

« Vertical Zoom and pan only in vertical direction

« Manually Set the start time and end time for horizontal axis, and set the scale for the vertical axis.



i N
Zoom and Pan Manually ﬁ

Horizontal - Date and Time

Start: 2013/ 8/19 @+ 11:13:03 =

End: 2013/ 8/19 B+ 11:1413 =

Vertical - Range of Readings

Scale: | 100% | |Enable

| ok || cancel

Zoom In and Pan

« Use the mouse to click and drag a box around any graph area to magnify the area selected.
« Press and hold the mid-button of the mouse at any graph location, and move the mouse to pan the graph area.

Zoom Out

« Click on the fﬂ Undo Last button to show last graph area.

« Click on the E Undo All button to show the original graph area.

Refresh
Export and Save

The software can save and open the *.dIg or *.mdlg file type in default. Use can also save as other file types,
including *.txt, *.csv, *.xIs, *.omp, and *.jpg



‘File | Edit Graph Logger Tool Help
£ open... Ctrl+0
Close
B save Ctrl+5
| Save As... Ctrl+Shift+5 |
B | Add File... Ctrl+5hift+0
Save As Template...
Use Template..,
Default Template...
&  Print... Ctrl+P
Print Preview
Print Setup...

Print and Export Options...

) ‘User can click on the Main Menu->Edit->Copy to copy the graph area to clipboard.
Graph List

User can use the graph list window to operate file and channel related functions easily.

« Add or remove file using right-button of the mouse at file area of the tree.
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« Open the channel related settings at channel area of the tree.
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» Show or hide the selected graph line.
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Statistics Window

The window will show the data logger information and statistics of readings

Statistics o
[=X File Name: kkk.dig - S/N: 130812DDD0000024 - Logger Name: Temp. and Humi. Logger

=l Details Readings/Total Sample Rate First Reading Time Last Reading Time Duration Time

i - e 10s 2013/8/19 11:13:13 2013/8M19 11:14:13 0d, Oh, 1m, 0s

[} Channels Number Name inil i Low Limit/High Limit Average Std.Dev. Unit
0 Temp. 37.8383 —23.0 38.0 02 c
1 RH 56.0/57.0 - 565 0.4 %rh
2 Dew Point 2771282 e 278 02 c

s lGraphList “'statistics | (=] Data Table

Data Table

The window will show the readings in table



Data Table

A B c D E
1 Serial Number 130812DDD000...
2 Logger Name Temp. and Humi...
3 File Name Kk dlg
4
5 2013/8/19 11:1... 383 23.0 587
6 2013/8M19 11:1... 382 230 56.1
7 2013/819 11:1... 381 23.0 56.3
8 2013/8119 11:1... | 38.0 230 56.0
] 20138189 11:1... | 38.0 23.0 57.0
[ JeraphList ™f'statistics | =] Data Table

Print

To print the graph, statistics and data table, click on the printer icon on standard toolbar or select Print from the File
pull-down menu.

User can also select the printed contents in the following dialog.

Print and Export Options

Please select the fllowing items that will be printed or
exproted in pdf file type:

Graph Statistics Data Table

| Cancel

Graph Settings

To set the graph area, click on the Graph Settings icon on graph toolbar or select graph settings from the graph pull-
down menu.

Graph Settings

Tile |Font | Color |Line |Axis |

Main Title:
Temp. and Humi. Logger

Sub Title:

Mark Data Points



Click right-button on graph area to show the pop-up menu below, Click “Mark Data Points” to show marks on all
sample point locations.

Add Comment...
Zoom and Pan Method »
b | Undo Last Ctr+2Z
2 Undo Al Cirl+A
Refresh F5
Grid Line Options 3
[#2 Mark Data Points
[~_-_ Graph Settings... Ctrl+G
™ | Copy Ctrl+C

Add Comment
User can add comment at any location of graph area, and also add comment for any sample points.

Add Comment...

Zoom and Pan Method 4
| Undo Last Ctrl+Z
f2\ | Undo Al Ctrl+A

Refresh F5

Grid Line Options 3
[# | Mark Data Points
F! Graph Settings... Ctrl+G
] | Copy Ctrl+C

Units Conversions

To create new unit and sub-unit, click on the units conversions from the tool pull-down menu.



D
Unit Category
Select unit category from list below:

[ 7]

[ Add New Unit Category ] l Remove Unit Category and Subunits

i

Subunits

Compound Line

User can create new graph data and line via expression and the readings from data logger. Click on the compound
line from tool pull-down menu.

o' - W
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